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1 始める前に 

1.1 このマニュアルの対象者 

このマニュアルは、シンクライアント専用 OSがインストールされたパソコンのディスク イメージ定義ファイルを作成

する ELIASの設定、および運用を行うシステム管理者を対象としています。このマニュアルの前提知識は、次

のとおりです。 

 ネットワークの操作 

 シンクライアント専用 OS 

1.2 このマニュアルについて 

このマニュアルは次のセクションで構成されています。 

章 説明 

1 始める前に マニュアルの表記規則、ELIAS の機能の概要 

2 ELIASの起動 ELIASの起動方法 

3 ELIAS のインターフェース ELIAS のメイン画面の概要 

4 ディスク イメージ定義ファイル

の定義 

ELIAS を使用してディスク イメージ定義ファイルを作成する方法  

5 コンテナーの操作 ELIAS を使用してコンテナーを作成および変更する方法 

6 高度な機能 USB メモリから行う更新 

7 セキュリティ 証明書を管理する方法、およびパッケージの有効性を確認する方法 

8 コマンド ELIAS のメニュー コマンドおよびショートカット キーのリファレンス 

1.2.1 よく使う略語 

このマニュアルに出てくる用語を次に示します。 

略語 説明 

FTP File Transfer Protocol（ファイル転送プロトコル） 

IP Internet Protocol（インターネット プロトコル） 

TCP Transmission Control Protocol（伝送制御プロトコル） 

1.3 詳細情報の参照先 

このマニュアルには、ELIASの概要と設定の手順が記載されています。詳細な情報は次のマニュアルから入手

できます。 

 シンクライアント専用 OS（ELIAS が生成するディスク イメージ定義ファイルを使用）に関する情報について

は、『シンクライアント専用 OS 管理者ガイド』をご覧ください。 

 FUTRO管理ツールを使用して、シンクライアント専用 OSがインストールされたパソコンを管理する方法に

ついては、『FUTRO管理ツール 管理者ガイド』をご覧ください。 
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1.4 概要 

1.4.1 ELIAS とは  

eLux Image Administration Service（ELIAS）では、シンクライアント専用 OSがインストールされたパソコン

のファームウェアを、容易に管理できます。各パソコンには既定のディスクイメージ定義ファイル（recovery.idf）が

付属しており、オペレーティングシステム、ソフトウェア、およびアプリケーションが含まれています。ファームウェアを

変更する場合は、新しいディスク イメージ定義ファイルを作成する必要があります。ELIAS を使用して、新しい

ディスク イメージ定義ファイル（*.idf）で、パソコン本体にインストールするソフトウェア パッケージを選択します。次

に、これらのパッケージは、パソコン本体のフラッシュメモリに保存されます。管理者は、ELIAS を使用してカスタ

ムメイドのイメージを作成することができます。 

1.4.2 ELIAS の機能 

ELIAS  には次の機能があります。 

 マウスクリックでソフトウェア イメージを作成できる、なじみやすいグラフィカル インターフェース 

 “コンテナー方式” を使用した、シンクライアント ファームウェアの容易な管理 

 ソフトウェア コンポーネントの有効／無効を選択して、使用可能なリソースを最適化する機能 

 フラッシュ サイズを超過しないようにするイメージ サイズ バー 

 ソフトウェアの依存関係の自動検証 

 最新バージョンのソフトウェアを簡単にインポートして追加する機能 

 パッケージとそのソフトウェア依存関係情報を容易にエクスポートする機能 

 インストールされているソフトウェアが正規のものであることを保証するデジタル署名 

1.5 ファームウェア更新について 

本パソコンには、オペレーティング システムと、Citrix
®
 ICA

®
 クライアント、RDP クライアント、ブラウザー、デスク

トップ ツールなどの基本ソフトウェアがすでに含まれています。これにより、ユーザーはすぐに本パソコンを使い始め

ることができます。 

ファームウェア（“ファームウェア” = フラッシュメモリに保存されたソフトウェア）を変更するには、“ファームウェア更新” 

を実行する必要があります。 

ファームウェア更新には次のステップがあります。 

1. 必要なプログラムとファイルをインストールする。 

ELIASは FUTRO管理ツールと同時にインストールされます。 

コンテナーは FTPまたは HTTPサーバーのルートディレクトリにコピーします。詳しくは『FUTRO管理

ツール 管理者ガイド』をご覧ください。 

2. 本パソコンにインストールするファームウェアを ELIASで“ディスク イメージ定義ファイル”（IDF）として定

義し、IDF を更新サーバー上のコンテナーに保存する 

3. 更新サーバーのパラメーターを使ってシンクライアントを構成する 

4. ローカルで、または FUTRO管理ツールを使用して更新を開始する 
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下の図は、相互依存関係とワークフローを示しています。  

 

図 1: ディスクイメージ定義ファイルの概念 
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1.6 ELIAS の用語 

ここでは、このマニュアルで使用する用語について説明します。作業を始める前にお読みください。 

 

EPM と FPM 

サーバーベースのコンピューティングでは、本パソコンにインストールされたクライアント ソフトウェアを使用してサー

バー ソフトウェアに接続します。クライアント ソフトウェアの例としては、ICA クライアントや RDP クライアントなど

があります。本 OSの構成はモジュールベースです。ELIASでは、シンクライアント専用 OS用にバンドルされて

いるクライアント プログラム（モジュール）を、パッケージと呼びます。 

本パソコンのフラッシュメモリに保存されたすべてのパッケージは、ファームウェアと呼ばれます。 

本パソコンに保存されたファームウェアを更新するときに、パッケージを個別に追加または削除します。この方が、

更新のたびに本パソコンに保存されているすべてのファームウェアを更新するより、かかる時間が短くてすみます。 

これらのソフトウェア パッケージは、eLux パッケージ モジュール（略して “EPM”）と機能パッケージ モジュール（略

して “FPM”）に分けられます。EPM（上位レベルのパッケージ）には、1つ以上の FPM（下位レベルのパッケー

ジ）が含まれます。  

 

コンテナー 

コンテナーは、特定のハードウェア用のファームウェア パッケージが含まれているディレクトリです。コンテナーには 

“container.ini” ファイルが含まれています。これは、重要な ID 情報を含むテキスト ファイルです。 

注意: www.myelux.comからパッケージを入手できますが、動作保証およびサポートの対象となるのは、シンク

ライアント専用 OSを搭載したシンクライアント製品に添付されているか、富士通がご案内しているパッケージの

みです。 

 

ディスク イメージ定義ファイル 

ディスク イメージ定義ファイル（略して “イメージ” または IDF）は、本パソコンにインストールするファームウェア パッ

ケージを定義します。IDF は ELIAS を使用して編集します。 

すべての IDF にオペレーティング システム（Base OS）を含める必要があります。さらに、適用するパッケージを

選択し、本パソコンにインストールするファームウェアをカスタマイズしてお客様のニーズにあった構成にすることがで

きます。本パソコンにすでにソフトウェアがインストールされている場合は、目的のパッケージを追加したり、プリイン

ストールされているイメージから不要なパッケージを削除したりできます。 

 

http://www.myelux.com/
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2 ELIASの起動 

2.1 ELIASの起動 

ELIAS を起動するには、次の 2つの方法があります。 

 Scout Enterprise 

Scout で、[View] > [Elias] の順にクリックします。  

 Windows 

「スタート」メニューで、[スタート] > [すべてのプログラム] > [Scout Enterprise] > [Elias] の順にクリック

します。 
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3 ELIAS のインターフェース 

この章では、ELIAS のメイン画面の概要について説明します。 

 

セクション 説明 

3.1 ELIAS のメイン画面 ELIAS のメイン画面の概要 

3.2 タイトル バー タイトル バーの説明 

3.3 メイン メニュー メイン メニューの説明 

3.4 ツール バー ツール バーの説明 

3.5 [Container] エリア [Container] エリアの概要 

3.6 [Image] エリア [Image] エリアの概要 

3.7 [Package information] エリア [Package information] エリアの概要 

3.8 アイコンによるセキュリティ ステータ

スの表示 

アイコンの概要 

3.9 イメージ サイズ バー イメージ サイズ バーの概要 
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3.1 ELIAS のメイン画面 

図 2: ELIAS のメイン画面 

 

ELIAS のメイン ウィンドウにはいくつかのコンポーネントがあり、この章ではそれらのコンポーネントについて説明し

ます。 

 タイトル バー 

 メイン メニュー 

 ツール バー 

 [Container] エリア 

 [Image] エリア 

 [Package information] エリア 

 アイコン 

 イメージ サイズ バー 

 

3.2 タイトル バー 

画面の上部にあるタイトル バーには、現在開いているディスク イメージ定義ファイルが表示されます。 
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3.3 メイン メニュー 

メニュー バーにはいくつかのメニューがあり、ELIAS で行う処理を選択します。各メニューには、コマンドのリストと対応す

るショートカット キー（使用可能な場合）が含まれています。 

 

図 3: メイン メニュー 

コマンドをすぐに実行するオプションや、追加情報を入力できるウィンドウを表示するオプションがあります。オプションの後

に “...” が続く場合は、ウィンドウが表示されます。そうでない場合は、コマンドがすぐに実行されます。 

3.4 ツール バー 

ツール バーを使うと、よく使うコマンドに 1回のクリックでアクセスできます。 

 

図 4: ツール バー 

 

ボタン 対応する操作 

新規 [Image] > [New]（「4.1 新しいイメージの定義」を参照） 

開く [Image] > [Open]（「4.2 イメージを開く」を参照） 

保存 [Image] > [Save]（「4.5 イメージの保存」を参照） 

印刷 [Image] > [Print]（「4.7 イメージ定義ファイルのリストを印刷」を参照） 

ヘルプ [Help] > [Help]（「8.1.5 [Help]」を参照） 

パッケージのインポート [Container] > [Import package]（「5.3 コンテナーへのパッケージのイ

ンポート」を参照） 

パッケージのエクスポート [Container] > [Export package]（「5.4 エクスポート機能を使用した

新しいコンテナーの作成」を参照） 

証明書管理 [Security] > [Manage certificates]（「7.2 証明書の管理」を参照） 

コンテナーの署名の確認 [Security] > [Check all packages in container]（「7.3.4 コンテ

ナー内のすべてのパッケージの署名を確認する」を参照） 

表 1: ツール バー ボタン 
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3.5 [Container] エリア 

コンテナーは、ハードウェア プラットフォーム用のファームウェア パッケージが含まれているディレクトリです。コンテナーには 

“container.ini” ファイルが含まれています。これは、重要な ID 情報を含むテキスト ファイルです。 

[Container] エリアには、コンテナーの内容を構成するパッケージのリストが表示されます。上位レベルのパッケージは 

eLux パッケージ モジュール（EPM）で、下位レベルのパッケージは機能パッケージ モジュール（FPM）です。EPM（上位

レベルのパッケージ）には、1つ以上の FPM（下位レベルのパッケージ）が含まれます。  

 

図 5: [Container] エリア 

 

コンテナー（「5.1 コンテナーを開く」を参照）を選択すると、次の情報が表示されます。 

 コンテナー名: コンテナーの名前です。インストール時に既定のコンテナー名を使用した場合、コンテナー名はコンテ

ナー ID と同じです。 

 コンテナーの説明: この説明は container.ini ファイル内の文字列であり、任意のテキストに変更できます。これは、

特定の目的（USB メモリから行う更新、会社の特定の部門、特定のハードウェアなど）のために、自分で作成した

コンテナーの説明を記述する場合に便利です。コンテナーの説明を変更する方法については、「5.5 コンテナーの

説明の変更」を参照してください。 

 コンテナーのパス: コンテナー ディレクトリのパスです。これはディスク イメージ定義ファイルのパスと同じにしてください。 

 使用可能なソフトウェア パッケージ: コンテナー内のソフトウェア パッケージです。上位レベルのパッケージは eLux 

パッケージ モジュール（EPM）で、下位レベルのパッケージは機能パッケージ モジュール（FPM）です。[Container] 

エリアでは、EPM（上位レベルのパッケージ）だけが表示されます。EPM は、ディスク イメージ定義ファイルに追加し

たりそこから削除したりできます。詳しくは、「4.3 イメージへのパッケージの追加」を参照してください。 
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3.6 [Image] エリア 

ディスク イメージ定義ファイル（IDF）はテキスト ファイルです。このファイルは、フラッシュメモリにインストールするパッケージ

について記述するリンクの集まりです。IDF は、コンテナー ディレクトリに保存する必要があります。 

[Image] エリアには、ディスク イメージ定義ファイルの内容を構成するパッケージの 2層の階層構造リストが表示されま

す。Windows エクスプローラーに習熟している場合は、簡単にその構造を管理できます。上位レベルのパッケージは 

eLux パッケージ モジュール（EPM）で、下位レベルのパッケージは機能パッケージ モジュール（FPM）です。EPM（上位

レベルのパッケージ）には、1つ以上の FPM（下位レベルのパッケージ）が含まれます。  

 

図 6: [Image] エリア 

ディスク イメージ定義ファイル（「4 ディスク イメージ定義ファイルの定義」を参照）を作成すると、次の情報が表示されま

す。 

 IDF 名 ファイル名です。 

 IDF サイズ 本パソコンにインストールされるイメージのサイズです。 

 IDF 内のファイル数 IDF 内のファイルの数です。 

 IDF パス IDF のパスです。これはコンテナーのパスと同じにしてください。 

 定義済みパッケージ IDF 内のソフトウェア パッケージ（EPM と FPM）です。FPM は、アクティブにしたり非アクティ

ブにしたりできます。詳しくは、「4.3 イメージへのパッケージの追加」を参照してください。 
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3.7 [Package information] エリア 

図 7: [Package information] エリア  

 

ソフトウェア パッケージ（EPM または FPM）を選択すると、次の情報が [Package information] エリア（画面の下部）

に表示されます。 

 パッケージ名 

 パッケージ バージョン番号 

 パッケージ サイズ 

 パッケージ内のファイルの数 

 署名のステータス 

 最後に署名を確認した日付 

 ソフトウェア製造者 

 パッケージの説明 

3.8 アイコンによるセキュリティ ステータスの表示 

ELIAS では、ソフトウェア パッケージ（eLux パッケージ モジュール [EPM] と機能パッケージ モジュール [FPM]）はアイコ

ンで表されます。  

ソフトウェア パッケージはさまざまなアイコンで表されます。 

   EPM:上位レベルのパッケージ（EPM）は、証明書のアイコンで表されます 

   FPM:（[Image] エリアのみ）下位レベルのパッケージ（FPM）は、チェック ボックスで表され

ます 

色は、EPM または FPM のセキュリティ状態を表します。 

緑 署名は有効です 

黄 署名はまだ確認されていません 

赤 署名が無効であるか、署名の確認中にエラーが発生しました（証明書が見つからない、

発行者がまだ信頼できない、など） 

FPM の場合、ボックスの内容は、選択の状態を表します（[Image] エリアのみ）。 

 灰色 必須（ひっす）パッケージです。選択または選択解除できません。 

 チェック パッケージは選択されています。本パソコンにインストールされます。 

 空 パッケージは選択されていません。本パソコンにインストールされないか、すでにインストー

ルされている場合は次回の更新時に削除されます。 
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3.9 イメージ サイズ バー 

ELIAS 画面の下部にあるバーは、ディスク イメージ定義ファイルのサイズの推定値を示します。  

図 8: イメージ サイズ バー 
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4 ディスク イメージ定義ファイルの定義 

この章では、ELIAS を使用したディスク イメージ定義ファイルの作成について説明します。コンテナーからパッケージを選択し、それらの

パッケージを [Image] エリアに転送すること、および機能パッケージ モジュールを個別に選択/選択解除することでディスク イメージ定

義ファイルを定義します。 

 

セクション 説明 

4.1 新しいイメージの定義 新しいディスク イメージ定義ファイルを定義する方法 

4.2 イメージを開く 既存のディスク イメージ定義ファイルを開く方法 

4.3 イメージへのパッケージの追加 ソフトウェア コンポーネントをアクティブ/非アクティブにする方法 

4.4 パッケージの依存関係 ELIAS でパッケージの依存関係を記述する方法 

4.5 イメージの保存 ディスク イメージ定義ファイルをコンテナー ディレクトリに保存するため

のルール 

4.6 サイズの制約 使用可能なフラッシュ メモリ サイズを超過しないようにする方法 

4.7 イメージ定義ファイルのリストを印

刷 

ディスク イメージ定義ファイルの内容のハードコピーを印刷する方法 

4.1 新しいイメージの定義 

新しいイメージを定義するには、[Image] > [New] を選択します。 

4.2 イメージを開く 

既存のイメージを変更するには、[Image] > [Open] を選択して、目的の IDF を参照します。 

ヒント: 既定のリカバリ イメージは、自動的にコンテナーにインストールされます。これらのイメージをテンプレートとして使

用するには、開いてから新しい名前で保存します（オリジナルのコピーはバックアップ用として常に保管してください）。 

4.3 イメージへのパッケージの追加 

パッケージをイメージに追加するには、次の操作を実行します。 

1. コンテナーを開きます（「5.1 コンテナーを開く」を参照）。 

2. [Container] エリアでパッケージを選択して、左矢印をクリックします。 

[Image] エリアにパッケージが表示されます。   

イメージの内容に不適合がないかテストされ、競合するパッケージが存在する場合は警告が表示されます。さ

らに、選択したパッケージが別のパッケージに依存している場合は、メッセージが表示されて、最初にその別の

パッケージを選択するように求められます。これにより、完成した IDF にソフトウェアの不適合がないことが検証

されます。 

ヒント:イメージ ウィンドウでパッケージを選択して右矢印をクリックすると、パッケージを削除します。 

3. すべての EPM には、1つ以上の機能パッケージ モジュール（FPM）が含まれます。[Image] エリアで、アイコン

の左側にある [+] をクリックしてソフトウェア パッケージを展開し、この EPM に含まれている FPM を表示しま

す。FPM のアイコンは、灰色、チェック マーク、または空白です。 

灰色: 無効にできない必須（ひっす）の機能 

チェック マーク: 有効になっている省略可能の機能 

空白: 無効になっている省略可能の機能 

ヒント: アイコンとその意味の説明については、「3.8 アイコンによるセキュリティ ステータスの表示」を参照してく

ださい。 

4. 機能のアイコンを選択してスペース キーを押し、機能を有効または無効にします。マウスの右ボタンをクリックし

て、ショートカット メニューを使用することもできます。 
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ヒント: 特定の機能に必要なパッケージは、『シンクライアント専用 OS 管理者ガイド』および『FUTRO管理

ツール 管理者ガイド』のその機能の章で紹介しています。 

 

追加情報 

 パッケージを IDF に追加すると、ソフトウェアに不適合がないかテストされます。ただし、ハードウェアとの互換性に関

する問題をチェックすることはできません。その確認は管理者が行う必要があります。 

 最初に選択する必要があるパッケージは BaseOS です。これは IDF に必須です。 

 次に、サーバーベースのコンピューター ネットワークで必要なソフトウェア（Citrix
®
 ICA

®、RDP、ブラウザーなど）を選

択します。 

 他にも、シンクライアント専用 OS用のソフトウェア（デスクトップ ツール、VNCサーバー、ミラーリング ソフトウェア）が

あります。 

 

4.4 パッケージの依存関係 

一部のパッケージは他のパッケージに依存しています。例えば、すべてのパッケージにはオペレーティング システム

（BaseOS）が必要なので、最初に選択する必要があるパッケージは BaseOSです。ELIASでは、パッケージが選択

されると自動的に依存関係を確認します。例えば、オペレーティングシステムをインストールする前にブラウザーをインス

トールしようとすると、次のエラーメッセージが表示されます。  

図 9: ELIAS エラーメッセージ 
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4.5 イメージの保存 

ディスクイメージ定義ファイルを保存するには、[Image] > [Save] をクリックします。  

 

ディスクイメージ定義ファイルを保存するときは、次のルールに従います。 

 ディスクイメージ定義ファイルはコンテナー ディレクトリに保存します。 

 名前に空白を含めることはできません。 

 ディスク イメージ定義ファイルにはわかりやすい命名規則を使用することを推奨します。後でディスク イメージ定義

ファイルに含まれるファームウェアとそのサイズを思い起こさせてくれる名前をお勧めします。例えば、128 MB の大き

さのイメージで ICA クライアントの場合は、”ica128.idf” などとします。 

4.6 サイズの制約 

イメージを定義する段階では、合計サイズの制限はありません。イメージの合計サイズは実際のフラッシュ メモリよりも大

きなサイズを設定することが可能であり、さまざまなソフトウェアの組み合わせを試したり、要求にかなうまでソフトウェア コ

ンポーネントの有効/無効を切り替えたりできます。ただし、最終的なイメージは合計フラッシュ サイズを超過できません。

ファイルを保存するときは、この点に注意してください。 
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4.7 イメージ定義ファイルのリストを印刷 

ELIAS ではディスク イメージ定義ファイルのソフトウェア パッケージと機能のリストを印刷することができます。[Image] > 

[Print]、[Print Preview]、および [Print Options] で、印刷設定を構成できます。  

図 10 は、[Print Preview] コマンドの例を示しています。 

 

図 10: ディスク イメージ定義ファイルの印刷プレビュー 

 

 

 



FUTRO 管理ツール イメージ定義ファイル説明書 

19 

5 コンテナーの操作 

この章では、ELIAS を使用したコンテナーの管理について説明します。 

 

セクション 説明 

5.1 コンテナーを開く コンテナーの開き方 

5.2 インターネットからのパッケージのダ

ウンロード 

www.myelux.com からソフトウェア パッケージをダウンロードする方

法 

5.3 コンテナーへのパッケージのイン

ポート  

ソフトウェアをコンテナーにインポートする方法  

5.4 エクスポート機能を使用した新し

いコンテナーの作成 

エクスポート機能を使って、カスタマイズした新しいコンテナーを生成

する方法 

5.5 コンテナーの説明の変更 コンテナーの説明を変更する方法 

5.6 コンテナーからのパッケージの削除 不要なパッケージをコンテナーから完全に削除する方法 

5.1 コンテナーを開く 

コンテナーを選択するには、[Container] > [Select] をクリックして、コンテナーを参照します。コンテナー ディレクトリが

見つかったら、そこに含まれている “container.ini” ファイルを開きます。 

5.2 インターネットからのパッケージのダウンロード 

新しいソフトウェア パッケージは、インターネットからダウンロードできます。無料の登録を 1 回行う必要があります。 

 ソフトウェア パッケージをインターネットからダウンロードするには 

1. Web サイト www.myelux.com にアクセスします。 

2. 左側のナビゲーション リンクで、[Login] をクリックします。 

3. まだ登録していない場合は、[Registration] をクリックして、指示に従います。1 ～ 3 日でログイン情報とパス

ワードが送られてきます。そうでない場合は、ログイン情報を入力して [Submit] をクリックします。 

4. メイン ページに [Download] と [Service] のエリアが表示されます。[eLux software packages] をクリックし

ます。[eLux software packages] ページが開きます。 

5. [eLux RL]で、[Released packages] の下にある列のリンクをクリックします。 

6. コンテナー ページに、コンテナー ID が表示されます。 

表示されるその他の重要な情報として、リリースの日付とソフトウェアが最後に更新された日時、使用するべき 

Scout と ELIAS のバージョン、および提供者があります。 

7. ダウンロードする個々のパッケージを探して（製品名は右側の列のリストにあります）、コンテナーのあるマシンの

ディレクトリに保存します。 

警告: パッケージを直接コンテナーに保存しないでください。 

8. 転送が完了したら、「5.3コンテナーへのパッケージのインポート」の、パッケージをコンテナーにインポートするため

の手順に従います。 

注意: www.myelux.comで入手できるパッケージのうち、動作保証およびサポートの対象となるのは、富士通がご案

内しているパッケージのみです。 

 

http://www.myelux.com/
http://www.myelux.com/
http://www.myelux.com/
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5.3 コンテナーへのパッケージのインポート 

コンテナーとは、ソフトウェア パッケージの集まりです。管理者は、IDF を定義するときに、本パソコンにインストールする

パッケージから一部を選択します。  

通常の使用では、コンテナー内のパッケージを変更する必要はありません。必要のないパッケージは影響を及ぼしません。 

ただし、次の場合は、コンテナーを更新する必要がある場合があります。 

 新しいクライアント ソフトウェアが使用できるようになった場合（Citrix
®
 ICA

®、RDPなど） 

 新しい BaseOSがリリースされた場合（eLux） 

 ソフトウェアのバグが修正された場合 

 

 個々のパッケージをコンテナーにインポートするには 

1. 「5.2 インターネットからのパッケージのダウンロード」ログオンするための手順に従います。 

2. 転送が完了したら、ELIAS を実行します。コンテナーを選択します（[Container] > [Select]）。 

3. [Container] メニューで、[Import package] を選択します。ダウンロードした *.zip ファイルを参照します。

ファイルが見つかったら、[Open] をクリックします。 

パッケージをインポートする機能を使うと、新しいソフトウェア パッケージをコンテナーにインポートするか、既存のパッケー

ジを上書きすることができます。どのソフトウェア パッケージの機能およびソフトウェア依存関係も影響を受けません。 

重要: 機能に関する問題が発生するのを避けるために、パッケージからコンテナーへのインポートには必ず ELIAS 

Import 機能を使用してください。ELIAS を使用せずに、パッケージを直接コンテナー ディレクトリにコピーした場合、関

連するコンポーネント（ソフトウェア）との依存関係が失われます。 

 

5.4 エクスポート機能を使用した新しいコンテナーの作成 

 

ヒント: USB メモリなどの持ち運び可能な記憶装置から更新を行うことができます。詳しくは、『シンクライアント専用

OS 管理者ガイド』および『FUTRO管理ツール 管理者ガイド』で説明されています。このセクションでは、持ち運び

可能な記憶装置に合った小さなコンテナーを作成する方法について説明します。「6.1 ファイルからの更新」も参照して

ください。 

 

パッケージをエクスポートする機能を使用して、カスタマイズした新しいコンテナーを構築できます。これは、容量の限られ

た USB デバイスから更新を行うときに便利です。 

1. 新しいディレクトリを作成します。container.ini ファイルをコンテナーからこの新しいディレクトリにコピーし

ます。 

2. ELIAS を実行します。コンテナーを選択します（[Container] > [Select]）。 

3. [Container] エリアで、パッケージをクリックして選択します。 

4. [Container] > [Export package] を選択します。作成した新しいディレクトリを参照します。ファイルが見つ

かったら、[Save] をクリックします。標準のファイル名は変更しないでください。選択したパッケージは、この新し

いディレクトリに保存されます。 

5. 完了するまで同じ手順を繰り返します。   

 

コンテナーを区別するには、コンテナーを別々のディレクトリに格納して、ハードウェアの種類に基づいてディレクトリに名前

を付けます。コンテナー マクロを利用するためには、標準のコンテナー名を使用する必要があることに注意してください。 

インポート機能の場合と同様、ソフトウェア パッケージに属するすべての機能が自動的に含められます。すべてのサブコ

ンポーネントが確実にエクスポートされるようにするには、Windows エクスプローラーではなく、エクスポート機能を使用し

てください。 
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5.5 コンテナーの説明の変更 

カスタマイズしたコンテナーを作成する場合は、区別できるように説明を変更してください。 

 コンテナーの説明を変更するには 

1. Windows エクスプローラーを起動して、コンテナー ディレクトリに移動します。 

2. メモ帳を使って “container.ini” ファイルを開きます。 

次のようなテキストが表示されます。 

 

[Global] 

ContainerID=UC_INTEL_P3-1.0-1 

ContainerDescription=eLux NG Container for Intel Pentium III 

 

3. “ContainerDescription” の値に、選択したものに関する新しい説明を入力して、ファイルを保存します。 

4. 次に ELIAS でコンテナーを開いたときに、この新しいコンテナーの説明が [Container] エリアに表示されます。 

重要: コンテナー ID は変更しないでください。 

5.6 コンテナーからのパッケージの削除 

古くなったソフトウェアをコンテナーから削除するには、そのパッケージを削除する必要があります。コンテナーからパッケー

ジを削除するには、ELIAS でコンテナーを開きます（[Container] > [Select]）。削除するソフトウェア パッケージを選

択して、Del キーを押すか、マウスの右ボタンをクリックして [Delete] をクリックします。 

確認のウィンドウが表示され、影響を受けるソフトウェア パッケージが知らされます。[Yes] をクリックして、パッケージを完

全に削除します。 

 

重要: パッケージの削除は取り消せません。パッケージを削除する前に、そのパッケージがディスク イメージ定義ファイル

（*.idf）によって使用されていないことを確認してください。削除したパッケージは復元できません。 
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6 高度な機能 

この章では、高度な機能について説明します。  

6.1 ファイルからの更新 

USB メモリ上のコンテナーへ直接アクセスして、ローカルで更新を実行できます。  

「4 ディスク イメージ定義ファイルの定義」の説明に従って IDF を作成し、コンテナーに保存します。コンテナー（IDF を

含む）の内容全体を USB メモリにコピーします。注意: 元のコンテナーのサイズを小さくする必要がある場合があります。

これを行うには、新しいコンテナーを作成するか（「5.4 エクスポート機能を使用した新しいコンテナーの作成」を参照）、

パッケージを削除します（「5.6 コンテナーからのパッケージの削除」を参照。必ず元のコンテナーのコピーをバックアップとし

て保管してください）。 

このトピックについての制限事項、ファームウェア パラメーター、および特別な注意事項については、『シンクライアント専

用 OS 管理者ガイド』および『FUTRO管理ツール 管理者ガイド』を参照してください。 
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7 セキュリティ 

この章では、証明書を管理する方法、およびパッケージの有効性を確認する方法について説明します。 

 

セクション 説明 

7.1 デジタル証明書について  信頼の階層構造の基本に関する概要 

7.2 証明書の管理 証明書を操作する方法、新しい証明書をインポートする方法、およ

び証明書の確認構成設定を設定する方法 

7.3 パッケージの有効性の確認 パッケージの署名の有効性を確認する方法、および署名の確認構

成設定を設定する方法 

7.1 デジタル証明書について 

ISO X.509 プロトコルでは、デジタル証明書と呼ばれるしくみを定義しています。これには、ユーザーの公開鍵（かぎ）が

含まれており、認証局（CA）と呼ばれる信頼されている実体によって署名されています。 

証明書は、EPM または FPM を識別するために使用されます（“パッケージは証明書を使って署名されます”）。 

証明書には次の情報が含まれます。 

 発行者: 証明書を発行した組織 

 対象: 証明書による識別の対象になるもの 

 有効期間: 証明書の開始日付と満了日付 

 公開鍵: データの暗号化に使用する、対象の公開鍵（かぎ） 

 発行者の署名: 証明書の真正性を証明するために使用する、証明書に付された CA のデジタル署名 

 

ELIAS では、次の種類のデジタル証明書が必要です。 

 信頼されている発行者 

 中間発行者 

 ルート証明書 

これにより、信頼されている発行者の証明書に署名した CA を識別します。ルート証明書は CA に属していま

す。ルート証明書は、信頼されている発行者と中間発行者の証明書の真正性を検証するために必要です。 

 

ELIAS には、次のルート証明書の組み込みサポートが付属しています。 

 TC TrustCenter Class 3 CA 

 

別の CA が署名した証明書を使用する場合は、証明書自体に加えて、その CA のルート証明書をインポートする必

要があります。 

セキュリティで使用する証明書は有効である必要があります。証明書が有効なのは指定された期間だけです。証明書

の有効期限が切れると、新しい証明書を発行してもらう必要があります。発行を行う認証局は、証明書を取り消すこ

ともできます。証明書を信頼する前に、その証明書が取り消されていないことを確認してください。 

現在 ELIAS に収められているすべての証明書のリストは、”信頼されているリスト” と呼ばれます。ELIAS では、現在

信頼されているリストにある証明書を使って、ソフトウェア パッケージの署名の有効性を確認します。有効期限の切れ

た証明書は、自動的に赤のマークが付けられ、検証には使用できなくなります。ELIAS には、信頼されているリストに

ある証明書の有効性を確認できるオンラインの OCSP 確認機能も用意されています。  
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7.2 証明書の管理 

このセクションでは、ELIAS の信頼されているリストに含まれている証明書を管理する方法について説明します。  

7.2.1 証明書情報の表示 

ELIAS を使用して、証明書内の情報を表示できます。 

図 11: [Manage certificate]ウィンドウ 

 

 証明書情報を表示するには 

1. [Security] > [Manage certificates] を選択します。または、ツール バーの対応するボタンをクリックします。 

[Manage certificates]ウィンドウが表示され、信頼されている証明書のリストが示されます。 

2. 目的のタブに移動します。 

3. 証明書をダブルクリックするか、証明書を選択して [Details] をクリックします。  

[Certificate]ウィンドウが表示されます。 

ウィンドウに表示される項目は次のとおりです。 

[General] 発行者、受信者、および有効期間が表示されます。 

[Details] 証明書情報が表示されます。 

[Certification path] 証明書パスが表示されます。プラス記号をクリックすると、展開します。 

4. 終了したら、[OK] をクリックしてウィンドウを閉じます。 
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7.2.2 OCSP の設定 

OCSP（Online Certificate Status Protocol）サーバーは、証明書のステータス（有効、取り消し、不明）を確認する

ために使用します。 

図 12: OCSP 設定 

 

 OCSP の設定を行うには 

1. [Security] > [Settings] を選択します。 

2. [Security Settings]ウィンドウで、次のパラメーターを入力します。 

[Proxy Server]（省略可能）プロキシ サーバーを使用してインターネットに接続する場合は、プロキシ サー

バーの IP アドレス（または名前）とポートを入力します。 

[OCSP Server] 一般に、OCSP サーバーは自動的に証明書から読み取られます。この情報が利用できな

い場合は、既定の OCSP サーバー（URL 形式）とポートを手動で入力できます。 

形式: http://<OCSP サーバーの URL> 

既定値は http://ocsp.openvalidation.org と 80 です。 

[OCSP Check within package verification] 署名を確認する前に毎回、証明書の有効性を自動的

に確認します。署名の確認については、「7.3 パッケージの有効性の確認」を参照してください。 

3. [Apply] をクリックします。 

7.2.3 手動での証明書の確認 

OCSP による確認を実行して、信頼されているリストにある証明書の有効性を定期的に確認してください。インター

ネット接続が必要です。 

 

 証明書の有効性を確認するには 

1. まだ行っていない場合は、OCSP の設定を行います。詳しくは、「7.2.2 OCSP の設定」を参照してください。 

2. [Security] > [Manage certificates] を選択します。 

3. [Manage certificates]ウィンドウで、目的のタブに移動し、証明書をクリックして選択します。 

4. [Verify] をクリックします。 

[Online verification]ウィンドウが表示されます。検証が行われます。 

5. プロセスが完了すると、ステータス メッセージが表示されます。検証に失敗した場合は、OCSP の設定が正し

いことを確認してください（ステップ 1）。 
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7.2.4 証明書の削除 

ELIAS では、信頼されているリストに入っている証明書はすべて信頼できると見なされます。証明書を信頼できなくなっ

た場合は、削除してください。 

証明書を削除するには、[Security] > [Manage certificates] を選択します。目的のタブに移動して、目的の証明

書をクリックして選択し、[Delete] をクリックします。 

7.2.5 証明書のインポート 

証明書を ELIAS に取り込むには、証明書をインポートする必要があります。ルート CA、中間 CA、または信頼されて

いる CA をインポートできます。証明書は *.cer または *.pem の形式にし、ローカル ネットワークで使用可能である必

要があります。  

 証明書を ELIAS にインポートするには  

1. 証明書を一時フォルダーに保存します。 

2. ELIAS で [Security] > [Manage certificates] を選択します。 

3. [Manage certificates]ウィンドウで、目的のタブに移動して、[Import] をクリックします。 

4. 証明書を参照します。 

7.2.6 証明書のエクスポート 

エクスポート機能を使用して、証明書を別の場所にコピーします。証明書のコピーは ELIAS 内に残ります。  

 証明書を ELIAS からエクスポートするには  

1. [Security] > [Manage certificates] を選択します。 

2. [Manage certificates]ウィンドウで、目的のタブに移動し、証明書をクリックして選択します。 

3. [Export] をクリックします。 

4. 証明書を保存するディレクトリを参照して、[Save] をクリックします。 

7.3 パッケージの有効性の確認 

UniCon Software GmbH によって署名されたファームウェアを使用するときは、そのファームウェアが UniCon 

Software のものであり、疑わしいサードパーティのものではないことを確信できます。本パソコンにインストールするソフト

ウェアが正規のもので、セキュリティを危険にさらすものではないことを確信できます。  

このセクションでは、ファームウェアの署名を確認する方法について説明します。既定では、ELIAS には、プリインストー

ルされた、信頼されている証明書が付属しています。証明書のインポートおよび管理については、「7.2 証明書の管

理」を参照してください。 

7.3.1 パッケージの署名を確認するための構成設定 

既定では、パッケージの署名の有効性は、信頼されているリストを使って内部的に確認されます。さらに、まず関係する

証明書のステータスを確認するように ELIAS を構成できます（OCSP 確認）。インターネット接続が必要です。 

 パッケージの署名に対して OCSP 確認を実行するように ELIAS を構成するには 

1. [Security] > [Settings] を選択します。 

2. [Security settings]ウィンドウで、プロキシ サーバーと既定の OCSP サーバーを入力します。詳しくは、

「7.2.2 OCSP の設定」を参照してください。 

3. [OCSP check within package verification] をクリックして選択します。 

4. [Apply] をクリックします。 

 

これ以降、パッケージの署名を確認する前に、関係する証明書に対する追加の OCSP 確認がオンラインで実行され

ます。 
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7.3.2 インポート時の署名の確認 

インポートするファームウェア（EPM および FPM）の署名を自動的に確認するには、[Security] > [Check 

signature during import] を選択します。これは切り替え式になっています。クリックすると、この機能の選択が解除

されて非アクティブになります。 

既定では、パッケージの署名の有効性は内部的に確認されます。追加の OCSP 確認を実行するには、「7.3.1 パッ

ケージの署名を確認するための構成設定」を参照してください。 

7.3.3 単一パッケージの署名の確認 

単一パッケージの署名を確認します。パッケージのある場所と確認対象を次に示します。 

[Container] エリア EPM とそれに対応する FPM を確認します。 

[Image] エリア 選択した内容に応じて、EPM とそれに対応する FPM、または単一の FPM を確認しま

す。 

 

 選択したパッケージの署名を確認するには 

1. パッケージをクリックして選択し、[Security] > [Check selected package] とポイントするか、パッケージを

マウスの右ボタンでクリックして [Check selected package] を選択します。 

2. 選択した EPM にあるすべての FPM の署名が確認されます。 

3. プロセスが終了すると、[Check signature]ウィンドウが表示されます。 

図 13: BaseOS 1.12-2 のパッケージ署名の確認 

 [Error]: 署名が正しくありません。一般的なエラーメッセージのリストについては、「7.3.6 トラブルシュー

ティング」を参照してください。 

 [Signature valid]: 正しい署名です。 

この情報は、パッケージを選択したときに、ELIAS のメイン画面の [Package information] > [Status] の下

にも表示されます。 

パッケージの署名の有効性は、証明書の内部リストを使って確認されます。証明書のリストに対して OCSP 確認を実

行する場合は、「7.3.1 パッケージの署名を確認するための構成設定」を参照してください。 
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7.3.4 コンテナー内のすべてのパッケージの署名を確認する 

 コンテナー内のファームウェアの署名を確認するには 

1. [Security] > [Check all packages in container] を選択します。または、ツール バーの対応するボタン

をクリックします。 

2. すべてのファームウェア（EPM および FPM）の署名が確認されます。 

3. プロセスが終了すると、[Check signature]ウィンドウが表示されます。 

表示される項目は次のとおりです。 

 [Verification failed] 署名が正しくありません。 

 [Signature valid] 正しい署名です。 

ヒント: EPM をダブルクリックすると、その FPM の署名ステータスが表示されます。一般的なエラー メッセージ

のリストについては、「7.3.6 トラブルシューティング」を参照してください。 

パッケージの署名の有効性は、証明書の内部リストを使って確認されます。証明書のリストに対して OCSP 確認を実

行する場合は、「7.3.1 パッケージの署名を確認するための構成設定」を参照してください。 

7.3.5 署名と証明書情報 

[Signature and certification information]ウィンドウは役に立つ診断ツールです。パッケージのある場所と確認

対象を表示します。 

[Container] エリア EPM とそれに対応する FPM を確認します。 

[Image] エリア 選択した内容に応じて、EPM とそれに対応する FPM、または単一の FPM を確認しま

す。 

 

 ソフトウェア パッケージのセキュリティ ステータスを表示するには 

1. パッケージをクリックして選択し、[Security] > [Check selected package] とポイントするか、パッケージを

マウスの右ボタンでクリックして [Signature and certification information] を選択します。 

2. このパッケージ内の個々の EPM および FPM のセキュリティ ステータスが表示されます。 

3. FPM をクリックして表示する情報を選択します。 

 [Check again] 選択した FPM の署名をもう一度確認します。設定については、「7.3.1 パッケージの

署名を確認するための構成設定」を参照してください。 

 [Details] この確認に使用する証明書の情報を表示します。パッケージをダブルクリックして表示すること

もできます。[Certificate]ウィンドウの詳しくは、「7.2.1 証明書情報の表示」を参照してください。署名

ファイルがない場合は非アクティブになります。その場合は、コンテナーを最新のソフトウェアに更新します。 

ウィンドウでパッケージをマウスの右ボタンでクリックすると、ショートカット メニューからこれらのコマンドにアクセスで

きます。 

 

さらに、ELIAS のメイン画面で、[Image] エリアまたは [Container] エリアのパッケージをクリックします。そのセキュリティ 

ステータス（エラー メッセージを含む）が [Package information] エリアの [Status] に表示されます。 
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7.3.6 トラブルシューティング 

一般的なエラー メッセージのリストを次に示します。 

 

エラー メッセージ 原因と対処方法 

[Error 21] Issuer not in the 
trusted list 

必要な信頼されている発行者の証明書が見つかりません。  

確認が進行中の間に、[Should the issuer be trusted?] というウィン

ドウが表示されたら [Yes] をクリックします。  

または、必要な証明書を www.myelux.com からダウンロードして、信

頼されているリストにインポートします。「7.2.5 証明書のインポート」を

参照してください。 

[Error 22] Root certificate 
cannot be found  

必要なルート CA 証明書が見つかりません。 

ELIAS で、パッケージをクリックして選択し、[Security] > [Signature 

and certification information] を選択します。パッケージをダブル

クリックします。[Manage certificates]ウィンドウが表示されます。

[Certification path] タブに移動して、見つからない証明書を確認し

ます。 

必要な証明書を www.myelux.com からダウンロードして、信頼され

ているリストにインポートします。「7.2.5 証明書のインポート」を参照し

てください。 

[Error 30] Certificate expired 証明書が期限切れになりました。  

必要な証明書を www.myelux.com からダウンロードして、信頼され

ているリストにインポートします。「7.2.5 証明書のインポート」を参照し

てください。 

[Error 40] Intermediate 
certificate cannot be found 

必要な信頼されている中間 CA の証明書が見つかりません。 

ELIAS で、パッケージをクリックして選択し、[Security] > [Signature 

and certification information] を選択します。パッケージをダブル

クリックします。[Manage certificates]ウィンドウが表示されます。

[Certification path] タブに移動して、見つからない証明書を確認し

ます。 

必要な証明書を www.myelux.com からダウンロードして、信頼され

ているリストにインポートします。「7.2.5 証明書のインポート」を参照し

てください。 

[Error 43] Certificate revoked 証明書が取り消されました。この発行者を信頼しないでください。 

[Error 103] No signature file 
found 

署名ファイルが見つかりません。最新バージョンのコンテナーまたはファー

ムウェア パッケージをダウンロードします。 

[Error 130] Connection failed OCSP サーバーに接続できませんでした。 

[Security settings]ウィンドウに移動します（[Security] > 

[Settings]）。 

インターネットに接続している場合は、プロキシ設定を確認します。 

インターネットに接続していない場合は、[OCSP check within 

package verification] チェック ボックスをオフにします。 

 

 

  

http://www.myelux.com/
http://www.myelux.com/
http://www.myelux.com/
http://www.myelux.com/
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8 コマンド 

この章は、さまざまなメニュー コマンドやキーボード コマンドのリファレンス ガイドになっています。必要に応じて、マニュアル内の他の場所

にある詳細情報の相互参照が用意されています。  

8.1 メイン メニュー 

8.1.1 [Image] 

[New] 

新しいディスク イメージ定義ファイルを開きます。  

[Open] 

既存のディスク イメージ定義ファイルを開きます。 

[Save]、[Save As] 

現在のディスク イメージ定義ファイルを保存します。 

[Export] 

現在のディスク イメージ定義ファイルを、選択したディレクトリにエクス

ポートします。 

 

[Print]、[Print Options] 

[Print Options]ウィンドウを開きます。ウィンドウの外観はオペレーティング システムによって異なることがあります。プリン

ター、用紙、およびフォーマットの設定を行うことができます。 

[Print Preview] 

印刷するディスク イメージ定義ファイルに含まれているソフトウェア パッケージのリストを表示します。「4.7イメージ定義

ファイルのリストを印刷」のセクションを参照してください。 

[<ディスク イメージ定義ファイル>] 

最近開いたディスク イメージ定義ファイルのリストです。それらのファイルに 1 回のクリックでアクセスできます。 

[Exit] 

ELIAS を閉じます。 
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8.1.2 [Container] 

[Select] 

コンテナーを参照して選択します。 

[Import Package] 

パッケージを既存のコンテナーにインポートします。ディストリビューターまたは Web か

ら新しいパッケージを受け取った後、そのパッケージをディスク イメージ定義ファイルに追加するには、そのパッケージをコン

テナーにインポートする必要があります。  

[Export Package] 

パッケージを別の場所にエクスポートします。例えば、新しいバージョンの Firefox を受け取り、すべての支社で使用でき

るようにする場合は、支社のコンテナー ディレクトリにエクスポートします。コンテナー ディレクトリは、他の HTTP または 

FTP サーバー上にあることもあります。 

[<コンテナー名>] 

最近開いたコンテナーのリストです。それらのコンテナーに 1 回のクリックでアクセスできます。 

8.1.3 [Security] 

[Check signature during import] 

選択すると、パッケージのインポート時に署名が自動的に確認され

ます。 

[Check all packages in container] 

コンテナー内のすべてのパッケージの署名を確認します。「7.3.4 コ

ンテナー内のすべてのパッケージの署名を確認する」を参照してくだ

さい。 

[Check selected package] 

[Container] エリアまたは [Image] エリアで選択したパッケージとそのコンポーネントの署名を確認します。「7.3.3 単一

パッケージの署名の確認」を参照してください。 

[Signature and certification information] 

[Container] エリアまたは [Image] エリアで選択したパッケージとそのコンポーネントのセキュリティ ステータスを表示しま

す。「7.3.5 署名と証明書情報」を参照してください。 

[Manage certificates] 

ELIAS の信頼されているリストにある証明書を管理できます。 

[Settings] 

オンラインの OCSP 確認の構成設定を入力します。 



FUTRO 管理ツール イメージ定義ファイル説明書 

32 

8.1.4 [View] 

[Toolbar] 

選択すると、ツール バーが表示されます。 

 

ツール バーのアイコンを使うと、[New]、[Open]、[Save]、[Print]、[Help]、[Context-Sensitive Help]、[Import 

package]、[Export package]、[Manage certificates]、[Check signatures of all packages in container] の

各コマンドに 1 回のクリックでアクセスできます。 

8.1.5 [Help] 

[Help] 

ELIAS のヘルプ トピックを開きます。ショートカット キー: F1。 

[About ELIAS] 

ソフトウェアの名前とバージョン番号を表示します。 

8.1.6 [Image] エリア 

パッケージを右クリックして表示されるショートカット メニュー:  

[Activate/Deactivate]:この FPM をアクティブまたは非アクティブにします。 

[Check selected [Container] エリアまたは [Image] エリアで選択したパッケージとそのコンポーネントの 

package]: 署名を確認します。 

[Signature and  

certification [Container] エリアまたは [Image] エリアで選択したパッケージとそのコンポーネントの 

information]: セキュリティ ステータスを表示します。 

8.1.7 [Container] エリア 

パッケージを右クリックして表示されるショートカット メニュー:  

[Check signature  [Container] エリアまたは [Image] エリアで選択したパッケージとそのコンポーネントの 

of package]: 署名を確認します。 

[Signature and  

certification [Container] エリアまたは [Image] エリアで選択したパッケージとそのコンポーネントの 

information]: セキュリティ ステータスを表示します。 

[Check all  
packages in  

container]: コンテナー内のすべてのパッケージの署名を確認します。 

[Delete package]: このパッケージをコンテナーから削除します。 

8.1.8 [Signature and Certification Information]ウィンドウ 

[Details]: この確認に使用する証明書の情報を表示します。 

[Check package  

new]: 選択したパッケージの署名をもう一度確認します。 
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8.2 ショートカット キー  

 

キーの組み合わせ 動作 

全般  

カーソル（矢印）キー: 

  

画面上の移動 

F1 オンライン ヘルプを開きます。 

Tab / Shift + Tab 画面上の移動 

[Container] エリア  

Ctrl + 左矢印キー: 

 

パッケージを IDF に追加します。 

Del 選択したパッケージをコンテナーから削除します。 

Insert [Import Package]ウィンドウを開きます。 

[Image] エリア  

カーソル（矢印）キー: 

   

定義された上位レベルの eLux パッケージ モジュールを展開したり閉じたりしま

す。 

Ctrl + 右矢印キー: 

 

パッケージをディスク イメージ定義ファイルから削除します。 

スペース バー 1. 定義された上位レベルの eLux パッケージ モジュールを展開したり閉じたりし

ます。 2. 下位レベルの機能パッケージ モジュールをアクティブにしたり非アクティ

ブにしたりします。 

 

さらに多くのショートカット キーが既定の Windows ショートカット キーに合わせて使用できます。 
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